(54) Title: METHOD OF CONFIGURING A HAND-HELD INSTRUMENT

(57) Abstract:
A method of configuring a hand-held instrument (10) for determining the concentration of a medically significant component of a body fluid or a control comprises providing a configuring computer (14) having a first port (18) for transmitting instructions and...

(57) Abrégé(suite)/Abstract(continued): data for configuring the instrument (10), providing on the instrument (10) a second port (17) for receiving the instructions and data from the configuring computer (14), coupling the first port (18) to the second port (17), transmitting instructions and data to configure the instrument (10) from the first port (18), receiving the instructions and data at the second port (17), and configuring the instrument (10) according to the instructions and data transmitted from the first port (10) and received at the second port (17).
INSTRUMENT SETUP UTILITY PROGRAM

A method of configuring a hand-held instrument (10) for determining the concentration of a medically significant component of a body fluid or a control comprises providing a configuring computer (14) having a first port (18) for transmitting instructions and data for configuring the instrument (10), providing on the instrument (10) a second port (17) for receiving the instructions and data from the configuring computer (14), coupling the first port (18) to the second port (17), transmitting instructions and data to configure the instrument (10) from the first port (18), receiving the instructions and data at the second port (17), and configuring the instrument (10) according to the instructions and data transmitted from the first port (10) and received at the second port (17).
METHOD OF CONFIGURING A HAND-HELD INSTRUMENT

Field of the Invention

This invention relates to a utility program useful in, for example, the setup of, and the communication with, instruments of the general type described in WO 99/28736.

Disclosure of the Invention

A method of configuring a hand-held instrument for determining the concentration of a medically significant component of a body fluid or a control comprises the steps of providing a configuring computer having a first port for transmitting at least one of instructions and data for configuring the instrument, providing on the instrument a second port for receiving said at least one of instructions and data from the configuring computer, coupling said first port to said second port, transmitting said one of instructions and data to configure said instrument from said first port, receiving said one of instructions and data at said second port, and configuring said instrument according to said one of instructions and data transmitted from said first port and received at said second port.

Illustratively according to the invention, the step of providing a configuring computer having a first port for transmitting at least one of instructions and data for configuring the instrument comprises the step of providing a configuring computer having a first port for transmitting instructions for configuring the instrument.

Further illustratively according to the invention, the step of providing a
configuring computer having a first port for transmitting at least one of instructions and data for configuring the instrument comprises the step of providing a configuring computer having a first port for transmitting data for configuring the instrument.

Additionally illustratively according to the invention, the hand-held instrument further comprises a display for displaying information related to the determined concentration. The step of transmitting said one of instructions and data to configure said instrument from said first port comprises the step of transmitting said one of instructions and data from said first port to configure said display.

Illustratively according to the invention, the method further comprises the step of transmitting one of instructions and data concerning determined concentration of a medically significant component of a body fluid from the second port to the first port.

Further illustratively according to the invention, the step of transmitting one of instructions and data concerning determined concentration of a medically significant component of a body fluid from the second port to the first port comprises the step of transmitting data concerning determined concentration of a medically significant component of a body fluid from the instrument to the computer.

Additionally illustratively according to the invention, the method further comprises updating a file in the computer with the transmitted data.

Illustratively according to the invention, the steps of transmitting said one of instructions and data to configure said instrument from said first port and receiving said one of instructions and data at said second port comprise transmitting said one of instructions and data through a fiber optic coupler from said first port to said second port.

Further illustratively according to the invention, the instrument comprises an instrument for determining the glucose concentration of blood, a blood fraction or a control.

Additionally illustratively according to the invention, the step of transmitting said one of instructions and data concerning determined concentration of a medically significant component of a body fluid from the second port to the first port comprises the step of transmitting said one of instructions and data concerning determined concentration of a medically significant component of a body fluid via a
modem from the second port to the first port.

Brief Description of the Drawings

The invention may best be understood by referring to the following detailed descriptions of illustrative embodiments and the accompanying drawings. In the drawings:

Fig. 1 illustrates a diagram of a system implementing a utility program according to the present invention;

Fig. 2 illustrates installation of a utility program according to the present invention where the program is distributed on one or more disks containing the program in one or more languages; and,

Figs. 3-60 illustrate various screens displayed during the running of a utility program according to the invention.

Detailed Descriptions of Illustrative Embodiments

This invention relates to a utility program useful in, for example, the setup of, and communication with, instruments of the general type described in WO 99/28736. Fig. 1 illustrates diagrammatically a system implementing the utility program 12 of the present invention. Setup of such an instrument 10 is handled by a portion of the program 12 sometimes referred to hereinafter as a Meter Setup Manager through a docking station provided for the instrument 10 on a personal computer (PC) 14. Communication between the docked instrument 10 and the PC 14 is coupled through a serial cable 16 such as, for example, a fiber optic connector, from a port 17 on instrument 10 to a port 18 on the PC 14.

Communication with a remote instrument 10', such as for the downloading of test results from storage on board the instrument 10' to the PC 14, is handled by a portion of the program sometimes referred to hereinafter as a Phone-In Manager. Phone-In Manager is conducted via telephone modems 20, 22 at the remote instrument 10' site and the PC 14.

Installation of the program 12, where the program is distributed on one or more disks containing the program in one or more languages, for example, is achieved as illustrated in Fig. 2. The user 24 may be asked to enter certain security information, for example, to verify the user 24's access to the PC 14 on which the
program 12 is loaded. A program 12 screen displays a list of utility languages from which the user 24 selects one. Illustratively, the user 24 will have to reinitialize the program 12 if, after selection of a utility language, the user 24 decides to select a different utility language.

5 **Meter Setup Manager**

Certain functions of the program can be performed only while an instrument of the general type discussed above is connected through, for example, a serial cable 16 rather than through modems 20, 22 and phone line 23, to the PC 14. A Meter Setup Manager icon, for example, an illustration of the instrument 10, will appear on one of the early screens. Once the user 24 clicks on the Meter Setup Manager icon, a copyright screen will appear briefly and will be followed by a “Welcome” screen illustrated in Fig. 3. The “Welcome” screen includes a list of tasks the Meter Setup Manager is capable of performing at the user 24’s option. This “Welcome” screen can be deselected at the user 24’s option. If the user 24 has deselected this screen, the default task will be initialized. If the user 24 has selected the “Create a Meter Setup” option, a standard Microsoft® Windows® development tool, known as the Wizard™, is launched.

Each screen in the meter setup routine is based on the template illustrated in Fig. 4. As an example of the screens based upon this template, Fig. 5 illustrates the “Enter personal information” screen. This screen displays three fields into which the user 24 is directed to enter information pertinent to the patient whose instrument 10 is being set up. The fields are patient name, patient identification, such as, for example, patient number, patient social security number, and so on, and health care provider computer 14 phone number. The next screen, illustrated in Fig. 6, is the “Glucose units/glucose ranges” screen. With this screen, the user 24 sets up the patient’s instrument 10’s glucose upper limit, glucose lower limit, hypoglycemic limit, and units of glucose measurement, for example, millimoles per liter (mmol/L) or milligrams per deciliter (mg/dL). The next screen, illustrated in Fig. 7, prompts the user 24 to set up the patient’s instrument 10 for the type(s) of insulin the patient is to take, for example, REGular, NPH or 90/10, and the dosage increments, for example, tenths of a unit, half units, or whole units.

With the next screen, illustrated with sample data in Fig. 8, the user 24
is prompted to load into the patient’s instrument 10 certain events which the patient is then capable of entering into the patient’s diary, which the instrument 10 is equipped to keep. From a library of, for example, 255 events, fifteen are chosen from which the patient may select to enter one in his or her diary with each glucose test result. Some one or more of these may be customized for the patient whose instrument 10 is being set up.

The next screen, illustrated with sample data in Fig. 9, permits the user 24 to load into the patient’s instrument 10 schedule control over any twenty-four hour period. A glucose test entry regimen dividing the twenty-four hour day into eight two- to five-hour intervals is the default regimen. This default regimen will be displayed on the screen, and the user 24 will be permitted to edit away from the default settings for the individual patient. Editing is done by clicking on the “Edit” button or by double clicking on any of the time block entries. Once the time block to be edited has been highlighted, its entries are available for edit. The program requires that every minute of the twenty-four hour period be accounted for, and does not permit any minute to be in two different time blocks. As a result, adjusting an entry will typically result in an automatic adjustment of another entry.

Advancing to the next screen, illustrated with sample data in Fig. 10, the information just entered is combined in the “Time block information” screen. The insulin types that were selected in the screen illustrated in Fig. 7 are the ones displayed on the screen illustrated in Fig. 10. If insulin type “None” was selected in connection with the setup illustrated in Fig. 7, no dosage can be selected in connection with the setup illustrated in Fig. 10. If the user 24 does not select an exercise type, he may not enter an exercise duration. The events list contains events which were selected in the events screen. The program does not permit the user 24 to list an event on the screen illustrated in Fig. 10 which was not one of the selected events in Fig. 8.

The screen illustrated in Fig. 11 is the meter setup “Insulin pump profile” screen. This screen contains a schedule list box similar to the time blocks schedule list box illustrated in Fig. 9. The user 24 selects an insulin type, and a start date and time for the insulin pump profile. The profile can contain no less than one time block and no more than twelve. The user 24 can insert or edit a time block from the screen. The user 24 can only delete a time block when the profile contains more
than one time block.

With reference to Fig. 12, the user 24 may insert a new time block by selecting a time block from the list and selecting the “Insert” button. The user 24 is presented with the option to insert the new time block either before or after the selected time block. The new time block, with a duration of one half hour, is inserted into the schedule list box. The user 24 can edit the start time of the newly added time block by double clicking on its entry in the list box, or by selecting the “Edit” button.

The user 24 can edit a specific insulin pump profile time block by double clicking on its entry in the profile time block list box. See Fig. 13. When this is done, the start time and insulin pump rate for the selected time block can be edited.

The user 24 can also edit a time block by highlighting its entry in the time block list box and selecting the “Edit” button. All times must be part of some time block, so the user interface does not permit gaps between time blocks. Nor can time blocks overlap. Setting the start time of one block automatically adjusts the end time of the previous time block to end one minute before. The user 24 can also delete a specific profile time block by highlighting its entry in the profile list box and selecting the “Delete” button. Unless the selected time block is the first time block, the preceding time block’s end time will be adjusted appropriately so that there are no gaps in the profile schedule. If the selected time block is the first time block, then the following time block’s start time will be adjusted appropriately.

Referring to Fig. 14, a number of miscellaneous options relating primarily to the display of information on the instrument 10 are also user 24 selectable. For example, the format in which decimals are displayed (X.X or X,X), whether a 24 hour clock or a twelve hour one (with AM and PM), the date format (month, day, year or day, month, year), whether the instrument 10 display 28 is to be backlit or not, and whether the instrument 10’s audio beeper is to be activated or not, are displayed for selection.

With the next screen, illustrated in Fig. 15, the user 24 selects from among a number, for example, eight, of languages in which instruments 10 can be programmed to display information, a number, for example, four, in which the particular instrument 10 being set up can display information at the patient’s option. The “Tip Messages” screen, illustrated in Fig. 16, enables a list control that permits the
user 24 to select a number, for example, ten, of tip messages for display on the
instrument 10 being set up. If the user 24 does not want tip messages displayed on the
patient's instrument 10, the user 24 may deselect the "Tip Messages Enabled for Meter
Setup" box. If this box is not checked, the user 24 must select individual messages
which the user 24 wants to appear on the patient's instrument 10 at appropriate times.

The user 24 may add custom tip messages to an instrument 10 being set
up for a patient. To do this, the user 24 selects the "Custom" button. The screen
illustrated in Fig. 17 is displayed. If the user 24 then selects the "Add" button, the
screen illustrated in Fig. 18 is displayed. If the user 24 selects the "Edit" button, the
screen illustrated in Fig. 19 is displayed. If the user 24 selects the "Remove" button,
the tip message highlighted in the screen illustrated in Fig. 17 is deleted. Once these
screens have been completed, the instrument 10 setup is complete. The user 24 is
presented with a dialog and given instructions on how to view and save the completed
setup. This screen is illustrated in Fig. 20.

Returning briefly to Fig. 3, if the user 24 selects the "Retrieve an
Existing Meter Setup from a Meter" option, and no instrument 10 is connected to the
PC 14, the user 24 is asked to connect the instrument 10 to the PC 14. If the user 24
selects "OK" and no instrument 10 is yet connected to the PC 14, the user 24 is again
asked to connect the instrument 10 to the PC 14. If the user 24 selects "Cancel," the
"Welcome" screen of Fig. 3 again appears. If the user 24 selects "Help," the help
facility is launched with troubleshooting information regarding connecting an
instrument 10 to the PC 14. If the user 24 selects the "Open an Existing Meter Setup
File" from the "Welcome" screen, a Microsoft® Windows® file opening common
dialog is launched. The user 24 may then select an instrument 10 setup file to edit or
cancel back to the "Welcome" screen.

If the user 24 has selected either the "Open an Existing Meter Setup
File" option or the "Retrieve an Existing Meter Setup from a Meter" option, ultimately
a summary screen of the general configuration illustrated in Fig. 21 will be displayed.
This screen displays the instrument 10 setup. The user 24 may edit this setup by
selecting the highlighted text on the screen. The user 24 is then presented with the
appropriate instrument 10 setup tab to edit instrument 10 setup options. The basic
elements of the summary screen as they appear on the Microsoft® Windows® 95
platform are illustrated in Fig. 21. The title bar contains a descriptor for the data
contained in the client area followed by the name of the software. This descriptor may
be “New Meter,” a filename, or a designation such as “John Smith’s Meter.” Below
the title bar is a menu bar. The menu bar is described later.

Below the menu bar, in the client area of the window, is a summary
screen. This summary screen contains the current instrument 10 setup settings. The
user 24 may edit the information contained on this screen by clicking on the underlined
text. This activates the instrument 10 setup tabs, similarly to the screen illustrated in
Fig. 22, “Instrument setup manager-tab template screen.” The tab control contains
screens that are nearly identical to the ones available via the instrument 10 setup
Wizard™, with the difference being that the Wizard™ provides a simple, step-by-step
approach to entering data, whereas the tab control gives the user 24 one-click access
to any screen. The tabs can also be used to set up instruments 10. They provide a
somewhat more powerful tool for doing this. However, it is suggested that, for the
first few times at least, the user 24 perform instrument 10 setup using the Wizard™ as
a learning tool.

With reference to Fig. 23, the contents of the “Personal” tab are
illustrated. As will be appreciated, the contents of this tab, and the appropriate user 24
interactions, are generally as described in connection with the screen illustrated in Fig.
5. Referring to Fig. 24, the contents of the “Glucose units/ranges” tab and the
appropriate user interactions are generally as described in connection with the screen
illustrated in Fig. 6. Turning to Fig. 25, the contents of the “Insulin type” tab are
illustrated. These contents and the associated user 24 interactions are generally as
described in connection with the screen illustrated in Fig. 7. Referring to Fig. 26, the
contents of the “Event markers” tab and the related user 24 interactions are generally
as described in connection with the screen illustrated in Fig. 8.

Turning to Fig. 27, the contents of the “Time blocks” tab are illustrated.
These contents and the associated user 24 interactions are generally as described in
connection with the screen illustrated in Fig. 9. With reference to Fig. 28, the contents
of the “Time blocks” tab and user 24 interactions are generally as described in
connection with the screen illustrated in Fig. 10. Referring to Fig. 29, the contents of
the “Insulin pump profile” tab and the related user 24 interactions are generally as
described in connection with the screen illustrated in Fig. 11. Turning to Fig. 30, the contents of the "Miscellaneous options" tab and user 24 interactions associated with it are generally as described in connection with the screen illustrated in Fig. 14. With reference to Fig. 31, the contents of the "Language" tab and user 24 interactions associated with it are generally as described in connection with the screen illustrated in Fig. 15. Referring to Fig. 32, the contents of the "Tip messages" tab and user 24 interactions associated with it are generally as described in connection with the screen illustrated in Fig. 16.

The user 24 may press a function key, F1 in the illustrated example, to open the help facility and obtain context sensitive help. All dialogs also have associated help buttons which access the help facility. The instrument 10 setup manager also has a help menu. The user 24 may cancel from the "Welcome" screen by selecting the "Cancel" button on that screen. When that action is taken, the welcome dialog box illustrated in Fig. 3 is dismissed and the main screen is displayed.

The user may select "Retrieve Patient Data from a Meter" connected to the computer 14 from the "Welcome" screen. If the user 24 then selects "OK," a sequence to retrieve patient data from a connected instrument 10 is initiated. This is exactly equivalent to selecting the "Retrieve Patient Data" option from the Meter menu. The Meter Setup Manager functions are divided into "File," "Meter," "View" and "Help" menus. See, for example, Fig. 21. The options under the "File" menu include "New," "Open . . . ," "Close," "Save," "Save As . . . ," "Print," "View Patient Report . . . ," "Print Patient Report . . . ," "Edit Patient Database . . . ," "Recent File List" and "Exit." The options under the "Meter" menu include "Retrieve Patient Data," "Retrieve Meter Setup," "Send Meter Setup," "Clear Patient Diary" and "COMMunication Port Settings . . . ," The options under the "View" menu include "Toolbar," "Status Bar" and "Options . . . ." The options under the "Help" menu include "Help topics" and "About . . . ."

The "File" menu contains commands that operate on Meter Setup Data and Patient Data. "New" returns all fields to their default states and initially opens a new instrument 10 setup with the Meter Setup Wizard. The user 24 may change this setting to Meter Setup Tabs by selecting "Options" under the "View" menu. If there is any unsaved data in the fields, the user 24 is prompted to save it. "Open" prompts the
user 24 to name a file to open and opens a Meter Setup File. If the selected file is not an instrument 10 setup file, an error message is displayed and the Summary Screen is blank. If the selected file is an instrument 10 setup file, then the data is initially displayed with the Summary Screen. The user 24 may edit the open document with the Meter Setup Tabs by clicking on the underlined text, or may edit the open document with the Meter Setup Wizard™ by selecting the Wizard™ toolbar button.

"Close" closes the currently open instrument 10 setup file. If the currently open instrument 10 setup file has not been saved, the user 24 will be prompted to save it. "Save" saves the currently open file. If the file has not yet been assigned a name, the user 24 will be prompted to assign it a name and location. "Save As" saves the current file under the assigned name. The user 24 is prompted to assign it a name and location. "Print" prints the current instrument 10 setup data. "View Patient Report..." prompts the user 24 to identify a patient data file to view using the patient name, instrument 10 serial number and the date received or the actual file name to select the file for viewing. "View Patient Report..." causes the selected report to be displayed in the format specified by the user 24. See Fig. 33. The user 24 selects the report format by selecting "Options" from the "View" menu. "View Patient Report Browser," Fig. 34, is accessed by the user 24 clicking on the "Browse..." button on the screen illustrated in Fig. 33. "View Patient Report Browser" permits the user 24 to scroll through the patient reports saved in the database for one the user wishes to view. "Print Patient Report..." causes the selected report to be printed. The user 24 selects the report to be printed in response to a prompt from this routine. See Fig. 35. "Print Patient Report Browser," Fig. 36, is accessed by the user 24 clicking on the "Browse..." button on the screen illustrated in Fig. 35. "Print Patient Report Browser" permits the user 24 to scroll through the patient reports saved in the database for one the user 24 wishes to print. "Edit Patient Database..." permits the user 24 to add, delete and edit patient name-to-instrument 10 serial number associations. See Figs. 37 and 38. "Recent File List" causes the four most recently opened files form the Patient Data and Meter Setup databases to be displayed, and permits the user 24 to open one of these files by selecting it from the list. "Exit" causes the computer 14 to exit from the Meter Setup Manager routine.

The "Meter" menu contains commands that act upon the instrument 10
that is connected to the computer 14. "Retrieve Patient Data" prompts the user 24 to enter a filename and a location to save the patient data to, and then retrieves the patient data from the instrument 10 connected to the computer 14. If no instrument 10 is connected to the computer 14, the user 24 is prompted to connect one. Once the data transfer is complete, the patient data is displayed in the format selected by the user 24. An "Options" screen illustrated in Fig. 39 permits the user 24 to select various Meter Setup Manager application options. For example, under the "Report settings" tab, the user 24 is prompted to select from among the various report formats: "Diary," "Glucose values," Trend," "Glucose graph," "Average trend," Glucose ranges," and "Hypoglycemic events." The user 24 is also prompted to select the time range for average trend, glucose ranges and hypoglycemic events reports. The user 24 is further prompted to select the glucose units, for example, mg/dL or mmol/L, for the reports. Under the "New meter setup" tab, the user 24 is prompted to select how new instrument 10 setup will be performed, permitting the user 24 to select the Meter Setup Wizard™, or use the tabs, or instructing the Meter Setup Manager always to ask how instrument 10 setup is to be performed. See Fig. 40 and the discussion of Fig. 22 above. Under the "Meter COM port" tab, the user 24 is prompted to select the computer 14 port 18 through which communication with the instrument 10 will be conducted. See Fig. 41. Referring to Fig. 42, under the "Startup" tab, the user 24 is prompted to indicate whether the "Welcome" screen, Fig. 3, should be displayed at startup.

"Retrieve Meter Setup" retrieves the Meter Setup Data from an instrument 10 and displays the instrument 10 setup data using the Summary Screen. If no instrument 10 is connected to the computer 14, the user 24 is prompted to connect one. Fig. 43 illustrates the screen which is displayed when instrument 10 setup status data is being transferred. When the instrument 10 setup data transfer is complete, if the instrument 10 serial number does not have associated with it a patient name, the "Enter Patient Name" prompt appears, Fig. 44, prompting the user 24 to enter the patient's name. The entered patient's name then appears on the summary screen.

"Send Meter Setup" sends instrument 10 setup data to an instrument 10 connected to the computer 14. If no instrument 10 is connected to the computer 14, the user 24 will be prompted to connect one. Before the instrument 10 setup data is
sent to the instrument 10, the user 24 is prompted to set the date and time on the
instrument 10. The user 24 has the option of not changing the instrument 10’s date
and time, synchronizing the instrument 10’s date and time to the computer 14’s or
manually setting the instrument 10’s date and time. See Fig. 45. As the instrument 10
setup data is being sent to the instrument 10, the screen illustrated in Fig. 46 is
displayed.

“Clear Patient Diary” clears the patient diary data of an instrument 10
connected to the computer 14. To prevent accidental clearing of diary, the user 24 is
prompted to save patient data to files before proceeding with clearing of patient diary
from an instrument 10. If no instrument 10 is connected to the computer 14, the user
24 will be prompted to connect one. “COM Port Settings” causes the screen
illustrated in Fig. 47 to be displayed. The user 24 is prompted to select the computer
14 port 18 through which communication with the instrument 10 will be conducted.

The “View” menu contains items that adjust the settings for the Meter
Setup Manager. The “Toolbar” command permits the user 24 to select whether the
toolbar is displayed. The “Status Bar” command permits the user 24 to select whether
the status bar, which is located at the bottom of the Meter Setup Manager application
screen, is displayed. “Options” creates a display which permits the user 24 to choose
various Meter Setup Manager application options. This multi-page display is
illustrated in Figs. 48-51. See the above discussion of Figs. 39-42.

The “Help” menu contains items that provide the user 24 with access to
information about the Meter Setup Manager. “Help Topics” displays the table of
contents of a help file. The user 24 may navigate via hyperlinks from the table of
contents to the contents of the various help file entries. The “About” entry causes the
version of the software and copyright notice information to be displayed.

The toolbar for the Meter Setup Manager contains command buttons
for commonly accessed features, such as “File-New,” “File-Open,” “File-Save,” “File-
Print,” “Meter Setup Wizard,” “Meter Communication-Retrieve Meter Setup,” “Meter
Communication-Send Meter Setup” and “Meter Communication-Retrieve Patient
Data.”

**Phone-In Manager**

All functions related to telephone modem 20, 22-based communication
between a patient’s instrument 10’ and the user 24’s computer 14 fall within the
control of the Phone-In Manager routine. Consequently, the Phone-In Manager
routine illustratively runs all of the time. Installation of the utility program 12 places a
link to the Phone-In Manager routine’s executable in the Microsoft® Windows®
startup folder, so that the Phone-In Manager routine launches automatically whenever
Microsoft® Windows® launches. In rare cases, the user 24 may need to launch the
Phone-In Manager routine by double clicking on its icon, for example, an illustration of
a telephone, or by other Microsoft® Windows® convention.

After the Phone-In Manager routine is launched, a copyright screen will
appear briefly. After launch, Phone-In Manager is generally minimized. This waiting
state is generally referred to herein as “Wait for New Calls.” The user 24 may also
“Review Calls” or “Perform Administrative Tasks.” From the perspective of a patient
who is using an instrument 10’, the patient’s data may be sent to the health care
professional’s office prior to a scheduled appointment. The patient may also phone the
patient data in to the health care professional’s office at any time, as necessary, to
permit the health care professional to review it. From the perspective of the health
care professional, such a connection is completely automatic. The patient performs all
necessary interactions to achieve the data transfer.

As previously noted, Phone-In Manager is always running, at least as a
background task. It will be active only when a phone call comes in to the health care
professional’s office computer 14 or when a user 24 restores it to display status on the
computer 14 monitor. A user 24 restores Phone-In Manager, for example, to review
calls or to change any of the Phone-In Manager configuration options. Fig. 52
illustrates the Phone-In Manager main screen restored. When patients phone their data
in via modems 20, 22 to the health care professional’s computer 14, the Phone-In
Manager keeps track of each call and the data that was received.

All calls are logged in order from most recent to oldest. Each logged
call is displayed in the list with the instrument 10’ serial number, patient’s name if
available, and the time and date of the phone call. The user 24 of the computer 14 may
view or print patient data by highlighting the desired patient’s instrument 10’ serial
number and selecting the “View” or “Print” button, respectively. The user 24 may also
select the “Auto Print” option, in which case incoming patient data is automatically
printed. The user 24 may also view or print patient data which has expired from the
Recent Calls list displayed in the screen illustrated in Fig. 52. Selecting the “View”
button results in the display of the selected patient’s data in the format illustrated in
Fig. 53. The user 24 can then choose to print or close this file. The user 24 can also
view this screen by selecting old files to view from the menu. The files can be selected
by the serial number of the instrument 10', patient name and data transfer date, or by
file name. Selecting the “Print” button results in the printing of the selected patient’s
data in the report format illustrated in Fig. 53. The user 24 can also print files which
have expired from the Recent Calls list by selecting old files to print from the menu.

Again, the files to be printed can be selected by the serial number of the instrument 10',
patient name and data transfer date, or by file name. If the “Auto Print” check box is
checked, patient reports will be printed upon receipt.

In Phone-In Manager as in Meter Setup Manager, features that are
accessed on a routine basis are located in the client area of the window. These
features and their data are easily accessible and reviewable. Other features which are
used less frequently are located in a standard Microsoft® Windows® menu bar. These
include the “File,” “View” and “Help” menus. The “File” menu contains commands
which operate on patient data. “View Patient Reports” permits the user 24 to view
older patient files by selecting the instrument 10' serial number, patient name and date
of receipt of data, or the actual file name. “Print Patient Reports” permits the user 24
to print older patient files by selecting the instrument 10' serial number, patient name
and date of receipt of data, or the actual file name. “Edit Patient Database” permits
the user 24 to add, delete and edit patient name to instrument 10' serial number
associations. “Print Setup” is the standard Microsoft® Windows® printer 30 setup
routine. “Exit” results in the Phone-In Manager routine being exited.

The “View” menu contains menu items that permit the user 24 to view
and modify various Phone-In Manager data stores. The “Status Bar” permits the user
24 to turn the status bar at the bottom of the main window on or off. “Phone Line
Status” displays a dialog, illustrated in Fig. 54, containing the states of all phone lines.

This permits the user 24 to enable or disable one or more of the phone lines 23
connected to the computer 14. When the utility program 12 is running in Windows®
95 and the user 24 clicks on the “Add” button or the “Properties” button on the screen
illustrated in Fig. 54, the screen illustrated in Fig. 55 is displayed. This screen permits the user 24 to select from modems 20, 22 configured using the control panel. When the utility program 12 is running in Windows® 3.1 and the user 24 clicks on the “Add” button or the “Properties” button on the screen illustrated in Fig. 54, the screen illustrated in Fig. 56 is displayed. This screen prompts the user 24 to set the serial port and baud rate for the modems 20, 22. When the utility program 12 is running in Windows® 3.1 and the user 24 clicks on the “Advanced Modem Settings” button on the screen illustrated in Fig. 54, the screen illustrated in Fig. 57 is displayed. This screen permits the user 24 to modify modem 20, 22 strings.

“Call Statistics” causes a screen illustrated in Fig. 58 to be displayed. Statistics for each phone line connected to the computer 14 are displayed. Statistics include the number of calls made to the line, the number of patient data transfers attempted, and the number of patient data transfers which succeeded. This screen also permits the user 24 to reset the statistics. “Options” permits the user 24 to modify the Phone-In Manager options. There are two tabs under “Options.” One tab, “Report Settings,” is illustrated in Fig. 59. This page permits the user 24 to select the type of Patient Data Report to view. The other tab, “Miscellaneous Options,” is illustrated in Fig. 60. This page permits the user 24 to select how many files are kept for each patient, and how many days’ calls are kept in the Recent Calls list. It also permits the user 24 to select to have patient reports printed automatically.

The “Help” menu contains items that provide the user 24 with access to information about the Phone-In Manager. “Help Topics” displays the table of contents of a help file. The user 24 may navigate via hyperlinks from the table of contents to the contents of the various help file entries. The “About” entry causes the version of the utility program 12 and copyright notice information to be displayed.
CLAIMS

1. A method of configuring a hand-held instrument for determining the concentration of a medically significant component of a body fluid or a control, the method comprising the steps of providing a configuring computer having a first port for transmitting at least one of instructions and data for configuring the instrument, providing on the instrument a second port for receiving said at least one of instructions and data from the configuring computer, coupling said first port to said second port, transmitting said one of instructions and data to configure said instrument from said first port, receiving said one of instructions and data at said second port, and configuring said instrument according to said one of instructions and data transmitted from said first port and received at said second port characterized in that at least said one of instructions and data include certain events, which a user of the hand-held instrument is then capable of entering with a test result into a user's diary which is maintained in the hand-held instrument, said events being chosen from a library of events.

2. The method of claim 1 wherein the step of providing a configuring computer having a first port for transmitting at least one of instructions and data for configuring the instrument comprises the step of providing a configuring computer having a first port for transmitting instructions for configuring the instrument.

3. The method of claim 2 wherein the step of providing a configuring computer having a first port for transmitting at least one of instructions and data for configuring the instrument comprises the step of providing a configuring computer having a first port for transmitting data for configuring the instrument.

4. The method of claim 1 wherein the step of providing a configuring computer having a first port for transmitting at least one of instructions and data for configuring the instrument comprises the step of providing a configuring computer having a first port for transmitting data for configuring the instrument.

5. The method of claim 1 wherein the hand-held instrument further comprises a display for displaying information related to the determined concentration, the step of transmitting said one of instructions and data to configure said instrument from said first port comprising the step of transmitting said one of instructions and data from said first port to configure said display.

6. The method of claim 2 wherein the hand-held instrument further comprises a display for displaying information related to the determined concentration,
the step of transmitting instructions from said first port to configure said instrument comprising the step of transmitting instructions to configure said display.

7. The method of claim 3 wherein the hand-held instrument further comprises a display for displaying information related to the determined concentration, the step of transmitting said one of instructions and data to configure said instrument from said first port comprising the step of transmitting data to configure said instrument display.

8. The method of claim 1 further comprising the step of transmitting one of instructions and data concerning determined concentration of a medically significant component of a body fluid from the second port to the first port.

9. The method of claim 8 wherein the step of transmitting one of instructions and data concerning determined concentration of a medically significant component of a body fluid from the second port to the first port comprises the step of transmitting data concerning determined concentration of a medically significant component of a body fluid from the instrument to the computer.

10. The method of claim 9 and further comprising updating a file in the computer with the transmitted data.

11. The method of claim 2 further comprising the step of transmitting one of instructions and data concerning determined concentration of a medically significant component of a body fluid from the second port to the first port.

12. The method of claim 11 wherein the step of transmitting one of instructions and data concerning determined concentration of a medically significant component of a body fluid from the second port to the first port comprises the step of transmitting data concerning determined concentration of a medically significant component of a body fluid from the instrument to the computer.

13. The method of claim 12 and further comprising updating a file in the computer with the transmitted data.

14. The method of claim 3 further comprising the step of transmitting one of instructions and data concerning determined concentration of a medically significant component of a body fluid from the second port to the first port.

15. The method of claim 14 wherein the step of transmitting one of instructions and data concerning determined concentration of a medically significant
component of a body fluid from the second port to the first port comprises the step of transmitting data concerning determined concentration of a medically significant component of a body fluid from the instrument to the computer.

16. The method of claim 15 and further comprising updating a file in the computer with the transmitted data.

17. The method of claim 4 further comprising the step of transmitting one of instructions and data concerning determined concentration of a medically significant component of a body fluid from the second port to the first port.

18. The method of claim 17 wherein the step of transmitting one of instructions and data concerning determined concentration of a medically significant component of a body fluid from the second port to the first port comprises the step of transmitting data concerning determined concentration of a medically significant component of a body fluid from the instrument to the computer.

19. The method of claim 18 and further comprising updating a file in the computer with the transmitted data.

20. The method of claim 5 further comprising the step of transmitting one of instructions and data concerning determined concentration of a medically significant component of a body fluid from the second port to the first port.

21. The method of claim 20 wherein the step of transmitting one of instructions and data concerning determined concentration of a medically significant component of a body fluid from the second port to the first port comprises the step of transmitting data concerning determined concentration of a medically significant component of a body fluid from the instrument to the computer.

22. The method of claim 21 and further comprising updating a file in the computer with the transmitted data.

23. The method of claim 6 further comprising the step of transmitting one of instructions and data concerning determined concentration of a medically significant component of a body fluid from the second port to the first port.

24. The method of claim 23 wherein the step of transmitting one of instructions and data concerning determined concentration of a medically significant component of a body fluid from the second port to the first port comprises the step of transmitting data concerning determined concentration of a medically significant component of a body fluid from the instrument to the computer.
component of a body fluid from the instrument to the computer.

25. The method of claim 24 and further comprising updating a file in the computer with the transmitted data.

26. The method of claim 7 further comprising the step of transmitting one of instructions and data concerning determined concentration of a medically significant component of a body fluid from the second port to the first port.

27. The method of claim 26 wherein the step of transmitting one of instructions and data concerning determined concentration of a medically significant component of a body fluid from the second port to the first port comprises the step of transmitting data concerning determined concentration of a medically significant component of a body fluid from the instrument to the computer.

28. The method of claim 27 and further comprising updating a file in the computer with the transmitted data.

29. The method of claim 1, 2, 3, 4, 5, 6 or 7 wherein the steps of transmitting said one of instructions and data to configure said instrument from said first port and receiving said one of instructions and data at said second port comprise transmitting said one of instructions and data through a fiber optic coupler from said first port to said second port.

30. The method of claim 29 wherein the instrument comprises an instrument for determining the glucose concentration of blood, a blood fraction or a control.

31. The method of claim 8, 9, 10, 11, 12, 13, 14, 15, 16, 17, 18, 19, 20, 21, 22, 23, 24, 25, 26, 27 or 28 wherein the step of transmitting said one of instructions and data concerning determined concentration of a medically significant component of a body fluid from the second port to the first port comprises the step of transmitting said one of instructions and data concerning determined concentration of a medically significant component of a body fluid via a modem from the second port to the first port.

32. The method of claim 31 wherein the instrument comprises an instrument for determining the glucose concentration of blood, a blood fraction or a control.
START

INSERT DISK AND LAUNCH SETUP PROGRAM

CHOOSE INSTALLATION LANGUAGE

ENTER NAME, COMPANY, AND SERIAL NUMBER

CHOOSE UTILITY LANGUAGE

END

Fig. 2
Welcome to the Accutility Meter Setup Manager! You can use this software to setup a new or existing meter. Choose one of the options below and then select the OK button.

- Create a New Meter Setup
- Open an Existing Meter Setup File.
- Retrieve an Existing Meter Setup from a Meter.
- Retrieve Patient Data from a Meter.

- Show this screen at startup.

Fig. 3
Fig. 4

Meter Setup Wizard -

Instructions on what to do on each screen appear here.

Interaction

Fig. 5

Meter Setup Wizard - Personal Information

Enter the Patient and Healthcare Provider Information below.

The Patient ID may be a number or a name that is up to 20 characters in length.

Patient Information

Name: 
ID: 

Healthcare Provider Information:

Healthcare Computer Phone Number: 

< Back Next > Cancel Help
Fig. 6

Meter Setup Wizard - Glucose Units/Ranges

Units of Measure
Glucose: ☐ mg/dL ☐ mmol/L

Glucose Limits
Upper Limit: 0 mg/dL
Lower Limit: 0 mg/dL
Hypo: 0 mg/dL

< Back Next > Cancel Help

Fig. 7

Meter Setup Wizard - Insulin Type

Select up to three Insulin Types. These will be the only types available in the meter.
Check the Insulin Logging box if you want to record insulin information in your meter.

☐ Insulin Logging Enabled for Meter Setup

Insulin Types
Insulin Type 1: <None> Insulin Type 2: <None> Insulin Type 3: <None>

Insulin Increment:
☐ Tenth Unit ☐ Half Unit ☐ Whole Unit

< Back Next > Cancel Help

SUBSTITUTE SHEET (RULE 26)
Meter Setup Wizard - Event Markers

Select up to 15 Event Markers to add to the Meter Setup
The Events will appear in the meter in the order they appear in the 'Events To Load Into Meter' list.
You have selected 15 Events

S Available Events ▲
  Active
  After Breakfast
  After Dinner
  ✓ After Exercise
  After Lunch
  ✓ After Meal
  Bed Time
  Before Breakfast
  Before Dinner
  ✓ Before Exercise
  Before Lunch
  ✓ Before Meal
  Cold Outdoors
  Different Food
  Drank Alcohol

Events to Load into Meter
  Before Meal
  After Meal
  Fasting
  Snack
  Feel Hypo.
  Before Exercise
  After Exercise
  Illness
  Invalid Test
  Other's Result
  User Defined
  Stress
  L1 Control
  L2 Control
  Oral Medication

S = Selected Event Markers

Meter Setup Wizard - Time Blocks

Time Block information is contained in the list below.
The minimum time span for a Time Block is 1/2 hour.
Editing the start time of a Time Block automatically adjusts the end time of the previous Time Block. No Time gaps are allowed between Time Blocks.
To edit an existing Time Block, select the Time Block and press the Edit button, or double click on the Time Block entry in the list.

<table>
<thead>
<tr>
<th>Time Block Name</th>
<th>3 Letter Name</th>
<th>Start Time</th>
<th>End Time</th>
<th>Duration</th>
</tr>
</thead>
<tbody>
<tr>
<td>Breakfast</td>
<td>Brk</td>
<td>6:00 AM</td>
<td>8:59 AM</td>
<td>3.0</td>
</tr>
<tr>
<td>Midmorning</td>
<td>Mmo</td>
<td>9:00 AM</td>
<td>11:59 AM</td>
<td>3.0</td>
</tr>
<tr>
<td>Lunch</td>
<td>Lun</td>
<td>12:00 PM</td>
<td>2:59 PM</td>
<td>3.0</td>
</tr>
<tr>
<td>Midafternoon</td>
<td>Maf</td>
<td>3:00 PM</td>
<td>5:59 PM</td>
<td>3.0</td>
</tr>
<tr>
<td>Dinner</td>
<td>Din</td>
<td>6:00 PM</td>
<td>7:59 PM</td>
<td>2.0</td>
</tr>
<tr>
<td>Evening</td>
<td>Eve</td>
<td>8:00 PM</td>
<td>9:59 PM</td>
<td>2.0</td>
</tr>
<tr>
<td>Bed time</td>
<td>Bed</td>
<td>10:00 PM</td>
<td>2:59 AM</td>
<td>5.0</td>
</tr>
<tr>
<td>Night time</td>
<td>Ngt</td>
<td>3:00 AM</td>
<td>5:59 AM</td>
<td>3.0</td>
</tr>
</tbody>
</table>

Fig. 8

Fig. 9
Fig. 10

Time Block Information

Three Letter Name: Brk
Start time: 6:00 AM End Time: 8:59 AM

Customize Time Block
Insulin Type 1: <None> Dose 0.0
Insulin Type 2: <None> Dose 0.0
Insulin Type 3: <None> Dose 0.0
Exercise Type: <None> Duration: 0.00
Carbohydrates: 0 grams
Event 1: No Event Event 3: No Event
Event 2: No Event Event 4: No Event

OK Cancel Help

Fig. 11

Meter Setup Wizard - Insulin Pump Profile

Check the Insulin Pump Logging box if you want to record Insulin Pump Information in your meter:

- Insulin Pump Logging Enabled in Meter Setup

Type of Insulin: <None>
Profile Start Date 11/09/98 Profile Start Time 2:50 PM

Time Block Name Start Time End Time Pump Rate
Time Block #1 12:00 AM 11:59 PM 0.0

Insert Edit... Delete

< Back Next > Cancel Help
Insert Time Block

Insert a new time block:

- Before 12:00 AM
- After 12:00 AM

OK  Cancel

Fig. 12

Insulin Pump Profile Time Block

Type of Insulin: <None>
Start Time: 12:30 AM
End Time: 11:59 PM
Insulin Pump Rate: 0.0 units/hour

OK  Cancel  Help

Fig. 13
## Meter Setup Wizard - Misc. Options

Select the appropriate Meter Customization Options

<table>
<thead>
<tr>
<th>Option</th>
<th>Selection</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Decimal Format</strong></td>
<td></td>
</tr>
<tr>
<td>Comma [,]</td>
<td>☐</td>
</tr>
<tr>
<td>Period [.]</td>
<td>☑</td>
</tr>
<tr>
<td><strong>Time Format</strong></td>
<td></td>
</tr>
<tr>
<td>24 Hour</td>
<td>☐</td>
</tr>
<tr>
<td>12 Hour</td>
<td>☑</td>
</tr>
<tr>
<td><strong>Date Format</strong></td>
<td></td>
</tr>
<tr>
<td>dd-mm-yy</td>
<td>☐</td>
</tr>
<tr>
<td>mm-dd-yy</td>
<td>☑</td>
</tr>
<tr>
<td><strong>Meter Back Light</strong></td>
<td></td>
</tr>
<tr>
<td>Off</td>
<td>☐</td>
</tr>
<tr>
<td>On</td>
<td>☑</td>
</tr>
<tr>
<td><strong>Beep</strong></td>
<td></td>
</tr>
<tr>
<td>Off</td>
<td>☐</td>
</tr>
<tr>
<td>On</td>
<td>☑</td>
</tr>
</tbody>
</table>

## Meter Setup Wizard - Languages

Select four Languages for the Meter Setup.

<table>
<thead>
<tr>
<th>Language</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dutch</td>
</tr>
<tr>
<td>English</td>
</tr>
<tr>
<td>French</td>
</tr>
<tr>
<td>German</td>
</tr>
<tr>
<td>Italian</td>
</tr>
<tr>
<td>Spanish</td>
</tr>
<tr>
<td>Swedish</td>
</tr>
</tbody>
</table>

---

**Fig. 14**

**Fig. 15**

SUBSTITUTE SHEET (RULE 26)
Meter Setup Wizard - Tip Messages

Select 10 Tip Messages to add to the Meter Setup from the list below.
To add Custom Tip Messages to the list below, select the 'Custom' button

☑ Tip Messages Enabled for Meter Setup

You have selected 10 Tip Messages.

<table>
<thead>
<tr>
<th>S</th>
<th>Available Tip Messages</th>
</tr>
</thead>
<tbody>
<tr>
<td>✓</td>
<td>Check your feet daily</td>
</tr>
<tr>
<td>✓</td>
<td>Choose a nutrition goal you can already do</td>
</tr>
<tr>
<td>✓</td>
<td>Choose an exercise goal you can already do</td>
</tr>
<tr>
<td>✓</td>
<td>Exercise helps keep your blood sugars in range</td>
</tr>
<tr>
<td>✓</td>
<td>Exercise is important for good diabetes management</td>
</tr>
<tr>
<td>✓</td>
<td>Exercise makes you more fit</td>
</tr>
<tr>
<td>✓</td>
<td>Ketones provide you with important information</td>
</tr>
<tr>
<td>✓</td>
<td>See your dentist every six months</td>
</tr>
<tr>
<td>✓</td>
<td>See your diabetes educator regularly</td>
</tr>
<tr>
<td>✓</td>
<td>See your doctor regularly</td>
</tr>
<tr>
<td>✓</td>
<td>See your eye doctor annually</td>
</tr>
<tr>
<td>✓</td>
<td>Tailor goals to fit your own lifestyle</td>
</tr>
</tbody>
</table>

S = Selected Tip Messages
C = Custom Tip Messages

< Back  Next >  Cancel  Help

Custom Tip Messages

Custom Tip Messages List:

new tip message
new tip message ddd

Add...  Edit...  Remove

Close  Help

SUBSTITUTE SHEET (RULE 26)
**Fig. 18**

Add Custom Tip Message

Enter the new tip message below [limit of 50 characters].

[Input field]

[OK]  [Cancel]  [Help]

**Fig. 19**

Edit Custom Tip Message

Edit the new tip message below [limit of 50 characters].

[Input field]

[OK]  [Cancel]  [Help]
You have finished selecting the Meter Options.
Select the "Finish" button to view the options selected.

To save the options selected [after viewing]:
From the File menu select 'Save' to save to a file.
From the Meter menu, select 'Send Meter Setup' to send the options to a meter that is connected to the computer.

Fig. 20
**Summary of Meter Setup**
(Select underlined text to make changes)

**Personal:**
- **Patient Name:** John Smith
- **Patient ID:** default
- **Healthcare Computer:** default
- **Phone Number:** default

**Glucose Units/Ranges:**
- **Units of Measure:** mg/dL
- **Upper Limit:** 0
- **Lower Limit:** 0
- **Hypo:** 0

**Insulin Type:**
- **Insulin Logging:** Disabled
- **Insulin Type 1:** < None >
- **Insulin Type 2:** < None >
- **Insulin Type 3:** < None >
- **Insulin Increments:** 0.1 units

**Event Markers:**
- Before Meal
- After Meal
- Fasting

For Help, press F1

---

**Fig. 21**

SUBSTITUTE SHEET (RULE 26)
Instructions on what to do on each screen appear here.

Interaction

**Fig. 22**

Accutility Meter Setup Manager

<table>
<thead>
<tr>
<th>Time Block</th>
<th>Insulin Pump Profile</th>
<th>Misc Options</th>
<th>Language</th>
<th>Tip Messages</th>
</tr>
</thead>
<tbody>
<tr>
<td>Personal</td>
<td>Glucose Units/Ranges</td>
<td>Insulin Type</td>
<td>Event Markers</td>
<td></td>
</tr>
</tbody>
</table>

Enter the Patient and Healthcare Provider Information below.

The Patient ID may be a number or a name that is up to 20 characters in length.

**Patient Information**

- **Name:** John Smith
- **ID:** default

**Healthcare Provider Information:**

- **Healthcare Computer Phone Number:** default

**Fig. 23**
Fig. 24

Accutility Meter Setup Manager

Time Block | Insulin Pump Profile | Misc Options | Language | Tip Messages
---|---|---|---|---
| | | | | |

Personal | Glucose Units/Ranges | Insulin Type | Event Markers
---|---|---|---
| | | | |

Units of Measure

Glucose: [ ] mg/dL [ ] mmol/L

Glucose Limits

Upper Limit: [ ] mg/dL
Lower Limit: [ ] mg/dL
Hypo: [ ] mg/dL

OK Cancel Help

Fig. 25

Accutility Meter Setup Manager

Time Block | Insulin Pump Profile | Misc Options | Language | Tip Messages
---|---|---|---|---
| | | | | |

Personal | Glucose Units/Ranges | Insulin Type | Event Markers
---|---|---|---
| | | | |

Select up to three Insulin Types. These will be the only types available in the meter.

Check the Insulin Logging box if you want to record insulin information in your meter.

Insulin Logging Enabled for Meter Setup

Insulin Increment:

- Tenth Unit
- Half Unit
- Whole Unit

Insulin Types

- Insulin Type 1: [ ] <None>
- Insulin Type 2: [ ] <None>
- Insulin Type 3: [ ] <None>

OK Cancel Help

SUBSTITUTE SHEET (RULE 26)
Accutility Meter Setup Manager

Select up to 15 Event Markers to add to the Meter Setup

The Events will appear in the meter in the order they appear in the 'Events To Load Into Meter' list.

You have selected 15 Events

S Available Events

Active
After Breakfast
After Dinner
✓ After Exercise
After Lunch
✓ After Meal
Bed Time
Before Breakfast
Before Dinner
✓ Before Exercise
Before Lunch
✓ Before Meal
Cold Outdoors
Different Food
Drank Alcohol

Events to Load into Meter

Before Meal
After Meal
Fasting
Snack
Feel Hypo.
Before Exercise
After Exercise
Illness
Invalid Test
Other's Result
User Defined
Stress
L1 Control
L2 Control
Oral Medication

S = Selected Event Markers

OK  Cancel  Help

Fig. 26

SUBSTITUTE SHEET (RULE 26)
Accutility Meter Setup Manager

Time Block information is contained in the list below.

The minimum time span for a Time Block is 1/2 hour. Editing the start time of a Time Block automatically adjusts the end time of the previous Time Block. No Time gaps are allowed between Time Blocks.

To edit an existing Time Block, select the Time Block and press the Edit button, or double click on the Time Block entry in the list.

<table>
<thead>
<tr>
<th>Time Block Name</th>
<th>3 Letter Name</th>
<th>Start Time</th>
<th>End Time</th>
<th>Duration</th>
</tr>
</thead>
<tbody>
<tr>
<td>Breakfast</td>
<td>Brk</td>
<td>6:00 AM</td>
<td>8:59 AM</td>
<td>3.0</td>
</tr>
<tr>
<td>Midmorning</td>
<td>Mmo</td>
<td>9:00 AM</td>
<td>11:59 AM</td>
<td>3.0</td>
</tr>
<tr>
<td>Lunch</td>
<td>Lun</td>
<td>12:00 PM</td>
<td>2:59 PM</td>
<td>3.0</td>
</tr>
<tr>
<td>Midafternoon</td>
<td>Maf</td>
<td>3:00 PM</td>
<td>5:59 PM</td>
<td>3.0</td>
</tr>
<tr>
<td>Dinner</td>
<td>Din</td>
<td>6:00 PM</td>
<td>7:59 PM</td>
<td>2.0</td>
</tr>
<tr>
<td>Evening</td>
<td>Eve</td>
<td>8:00 PM</td>
<td>9:59 PM</td>
<td>2.0</td>
</tr>
<tr>
<td>Bed time</td>
<td>Bed</td>
<td>10:00 PM</td>
<td>2:59 AM</td>
<td>5.0</td>
</tr>
<tr>
<td>Night time</td>
<td>Ngt</td>
<td>3:00 AM</td>
<td>5:59 AM</td>
<td>3.0</td>
</tr>
</tbody>
</table>

Fig. 27

SUBSTITUTE SHEET (RULE 26)
Fig. 28
Accuutility Meter Setup Manager

<table>
<thead>
<tr>
<th>Personal</th>
<th>Glucose Units/Ranges</th>
<th>Insulin Type</th>
<th>Event Markers</th>
</tr>
</thead>
<tbody>
<tr>
<td>Time Block</td>
<td>Insulin Pump Profile</td>
<td>Misc Options</td>
<td>Language</td>
</tr>
</tbody>
</table>

Check the Insulin Pump Logging box is you want to record Insulin Pump Information in your meter:

- Insulin Pump Logging Enabled in Meter Setup

**Type of insulin:** 10/90

**Profile Start Date:** 11/09/97

**Profile Start Time:** 2:50 PM

<table>
<thead>
<tr>
<th>Time Block Name</th>
<th>Start Time</th>
<th>End Time</th>
<th>Pump Rate</th>
</tr>
</thead>
<tbody>
<tr>
<td>Time Block #1</td>
<td>12:00 AM</td>
<td>12:29 AM</td>
<td>0.0</td>
</tr>
<tr>
<td>Time Block #2</td>
<td>12:30 AM</td>
<td>11:59 PM</td>
<td>0.0</td>
</tr>
</tbody>
</table>

---

Fig. 29

---

SUBSTITUTE SHEET (RULE 26)
Accutest Meter Setup Manager

Personal  Glucose Units/Ranges  Insulin Type  Event Markers
Time Block  Insulin Pump Profile  Misc Options  Language  Tip Messages

Select the appropriate Meter Customization Options

Decimal Format
- ○ Comma [,]  ○ Period [.]

Time Format
- ○ 24 Hour  ○ 12 Hour

Date Format
- ○ dd-mm-yy  ○ mm-dd-yy

Meter Back Light
- ○ Off  ○ On

Beeper
- ○ Off  ○ On

OK  Cancel  Help

Fig. 30
Accutest Meter Setup Manager

Select four Languages for the Meter Setup.

Languages

☐ Dutch
☐ English
☐ French
☐ German
☐ Italian
☐ Spanish
☐ Swedish

OK  Cancel  Help

Fig. 31
Accutility Meter Setup Manager

<table>
<thead>
<tr>
<th>Personal</th>
<th>Glucose Units/Ranges</th>
<th>Insulin Type</th>
<th>Event Markers</th>
</tr>
</thead>
<tbody>
<tr>
<td>Time Block</td>
<td>Insulin Pump Profile</td>
<td>Misc Options</td>
<td>Language</td>
</tr>
</tbody>
</table>

Select 10 Tip Messages to add to the Meter Setup from the list below.
To add Custom Tip Messages to the list below, select the 'Custom' button.

- Tip Messages Enabled for Meter Setup

You have selected 10 Tip Messages.

<table>
<thead>
<tr>
<th>S</th>
<th>C</th>
<th>Available Events</th>
</tr>
</thead>
<tbody>
<tr>
<td>✓</td>
<td></td>
<td>Check your feet daily</td>
</tr>
<tr>
<td>✓</td>
<td></td>
<td>Choose a nutrition goal you can already do</td>
</tr>
<tr>
<td>✓</td>
<td></td>
<td>Choose an exercise goal you can already do</td>
</tr>
<tr>
<td>✓</td>
<td></td>
<td>Exercise helps keep your blood sugars in range</td>
</tr>
<tr>
<td>✓</td>
<td></td>
<td>Exercise is important for good diabetes management</td>
</tr>
<tr>
<td>✓</td>
<td></td>
<td>Exercise makes you more fit</td>
</tr>
<tr>
<td>✓</td>
<td></td>
<td>Ketones provide you with important information</td>
</tr>
<tr>
<td>✓</td>
<td></td>
<td>See your dentist every six months</td>
</tr>
<tr>
<td>✓</td>
<td></td>
<td>See your diabetes educator regularly</td>
</tr>
<tr>
<td>✓</td>
<td></td>
<td>See your doctor regularly</td>
</tr>
<tr>
<td>✓</td>
<td></td>
<td>See your eye doctor annually</td>
</tr>
<tr>
<td>✓</td>
<td></td>
<td>Tailor goals to fit your own lifestyle</td>
</tr>
</tbody>
</table>

S = Selected Tip Messages
C = Custom Tip Messages

Fig. 32
<table>
<thead>
<tr>
<th>Patient Name</th>
<th>Serial number</th>
</tr>
</thead>
<tbody>
<tr>
<td>John Smith</td>
<td>0005040225</td>
</tr>
</tbody>
</table>

**Fig. 33**
Fig. 34
<table>
<thead>
<tr>
<th>Patient Name</th>
<th>Serial number</th>
</tr>
</thead>
<tbody>
<tr>
<td>John Smith</td>
<td>0005040225</td>
</tr>
</tbody>
</table>

**Fig. 35**
Fig. 36
Fig. 37

Fig. 38
Fig. 39
Fig. 40

Create a New Meter Setup using

- **Meter Setup Wizard**
- Meter Setup Tabs
- Always Ask
Fig. 42

Fig. 43
Enter Patient Name

The meter serial number has no corresponding patient name. Please enter the patient's name.

Meter Serial Number: 0005040225

Patient Name:

[OK] [Cancel] [Help]

Fig. 44
Fig. 45
Fig. 46
Fig. 47
Fig. 48
Create a New Meter Setup using

- **Meter Setup Wizard**
- **Meter Setup Tabs**
- **Always Ask**

**Fig. 49**
Fig. 50
Fig. 51
Fig. 52
**Diary Report**

<table>
<thead>
<tr>
<th>Date</th>
<th>Time</th>
<th>Glucose (mg/dL)</th>
<th>Insulin Type</th>
<th>Insulin Dosage</th>
<th>Events</th>
<th>Other</th>
</tr>
</thead>
<tbody>
<tr>
<td>1/16/98</td>
<td>7:30 AM</td>
<td>236</td>
<td>70/30</td>
<td>22.0</td>
<td>Before Meal</td>
<td>bG=high, Carbs=60g</td>
</tr>
<tr>
<td>1/16/98</td>
<td>12:28 PM</td>
<td>85</td>
<td></td>
<td></td>
<td>Before Meal</td>
<td>Carbs=60g</td>
</tr>
<tr>
<td>1/16/98</td>
<td>2:45 PM</td>
<td>179</td>
<td>Reg</td>
<td>2.0</td>
<td>After Meal</td>
<td>Carbs=30g</td>
</tr>
<tr>
<td>1/16/98</td>
<td>5:20 PM</td>
<td>314</td>
<td>70/30</td>
<td>8.0</td>
<td>Before Meal</td>
<td>bG=high, Carbs=60g</td>
</tr>
<tr>
<td>1/16/98</td>
<td>8:00 PM</td>
<td>250</td>
<td></td>
<td></td>
<td>bG=high</td>
<td></td>
</tr>
<tr>
<td>1/17/98</td>
<td>12:15 AM</td>
<td>275</td>
<td></td>
<td></td>
<td>bG=high</td>
<td></td>
</tr>
<tr>
<td>1/17/98</td>
<td>7:58 AM</td>
<td>151</td>
<td>70/30</td>
<td>22.0</td>
<td>Before Meal</td>
<td>Carbs=45g</td>
</tr>
<tr>
<td>1/17/98</td>
<td>10:00 AM</td>
<td>180</td>
<td></td>
<td></td>
<td>After Meal</td>
<td>Carbs=15g</td>
</tr>
</tbody>
</table>

**Fig. 53**
Fig. 54

Fig. 55
Fig. 56

Phone Line Configuration

Port: COM1
Max speed: 9600
Advanced Modem Settings...
OK Cancel Help

Fig. 57

Advanced Modem Settings

Setup:
Restore:
Answer: ATA^M
Set Defaults
OK Cancel Help

Fig. 58

Phone Call Statistics

<table>
<thead>
<tr>
<th>Calls Answered</th>
<th>Transfer Attempts</th>
<th>Successful Transfers</th>
</tr>
</thead>
<tbody>
<tr>
<td>Line 1</td>
<td>23</td>
<td>7</td>
</tr>
<tr>
<td>Line 2</td>
<td>7</td>
<td>1</td>
</tr>
</tbody>
</table>

Close Reset Help

SUBSTITUTE SHEET (RULE 26)
**Fig. 59**

- **Report Formats**
  - Diary
  - Glucose Values
  - Trend
  - Glucose Graph
  - Average Trend
  - Glucose Ranges
  - Hypoglycemic Events

- **Range for Average Trend, Glucose Ranges and Hypo Events reports**
  - 30 days ▼
  - Glucose Units
    - ○ mg/dL
    - ○ mmol/L

**Fig. 60**

- **Number of files to keep for each patient:** 10
- **Number of previous days in recent calls list:** 7

- **Automatically print received patient data**

(SUBSTITUTE SHEET (RULE 26))